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Tabs3 Getting Started Guide 

Congratulations! You’ve made the decision to work with Tabs3. Now, let us show you how to get started 

and where to go when you need more information. 
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Before You Start 
Before you can get started, you need to install Tabs3.  

Installation 
If you have not yet installed Tabs3, it’s easy to do. 

Simply follow the instructions provided with the CD. 

Tip:  During the installation of the software, you will 

be asked if you would like to install the Starter Data. We recommend installing Starter Data for a faster 

start. Starter data includes transaction codes, statement templates, categories, and more.  

Starting Tabs3 
1. From the Windows Start button, point to All Programs, click Tabs3 & PracticeMaster, and then 

click Tabs3. 
2. You will be asked to enter your User ID and Password at the Logon window. For now, use the 

User ID of (BLANK) with no password; simply leave both fields blank and click OK. This 
temporary User ID is the default Manager User ID. You can set up users in System Configuration 
after you have set up Tabs3. 

More Info – Installation 
Printed instructions come with the CD. If you do not have these 

instructions, a copy is on the CD in the DOCS folder. 
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Setting Up Tabs3 
Tabs3 uses two fields named Key Type and 

Decimal Places to determine your client 

numbering scheme. 

There are three different Key Types:  Numeric, 

Mixed, or Alpha. Typically the client portion of 

the Client ID is left of the decimal and the matter number is right of the decimal.  The Decimal Places 

determines the number of digits for the matter position. Many firms will use 2 or 3 to start with. It can 

be enlarged later as needed.  

 A  Numeric Key Type allows only numbers in the client and matter portions of the Client ID.  
123.45, 20.001, and 5000.110701 are all examples of a Numeric Client ID. 

 A  Mixed Key Type allows alpha or numeric characters in the client portion of the Client ID but 
only allows numeric characters in the matter portion of the ID.  ABC.01, DE12.004, and 
Smith.110801 are all examples of a Mixed Key Type. 

 An Alpha Key Type allows both alpha and numeric characters in the client and matter portions 
of the Client ID.  ABC.DE and FG12.H34 are examples of an Alpha Key Type. 
 

There are advantages to using a Numeric Key Type. When using a Numeric Key Type, the primary 

advantage is that Tabs3 can automatically assign new Client IDs and Matter IDs. When using a Mixed 

Key Type, Tabs3 can automatically assign new Matter IDs, but not new Client IDs. If you are not sure 

which Key Type to use, we recommend using a Numeric Key Type.  

You will need to define your Key Type and Decimal Places before using Tabs3.  

Step 1 – Customize Tabs3  
The first time you start Tabs3 after installing the software, the Tabs3 Customization window will be 

opened. The Customization window consists of several tabs. There are a few fields that must be set 

before proceeding.  

Configuring the Tabs3 Customization Window 
1. Start Tabs3. The Customization window will be opened automatically.  

Tip: If the Customization window does not open automatically, use the Utilities | Customization 
menu to open the window, and see the note following these procedures for more information.  

2. On the Main tab: 
a. Specify the desired Key Type and Decimal Places as described above. 
b. Specify the First Month of Reporting Year field. Most firms use January, but some firms’ 

fiscal year starts with a different month. (Note: This month is different than the current 
reporting month.)  

3. On the Options tab: 
a. Specify whether you want statements numbered at the firm or client level in the 

Statement Numbering field. (Note: We recommend numbering at the firm level so you 
can easily search by statement number when entering payments.) 

4. On the Rates tab: 

More Info – Customization 
Help Topics  

 Press F1 in the Customization window 

 Click the Index tab and type “Client ID” 
 

Tabs3 Manual – Chapter 2:  Using & Setting Up Tabs3 

http://www.tabs3.com/support/manuals/t3manual.pdf
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a. If your state requires you to charge sales tax on services, expenses, or advances, select 
the corresponding check box and enter the tax rate in the Rate 1 field. 

b. If you would like to charge finance charge on past due balances, select the 
corresponding check boxes and enter the annual rate in the Rate 1 field (e.g., enter 
12.00 if you charge an annual finance charge of 12% per year). 

5. On the Client Defaults tab: 
a. Specify the defaults that will be used when adding a new client.  
b. If assessing sales tax, under the Sales Tax section, select the default sales tax rate.  
c. If assessing finance charge, select the Assess Finance Charge check box, the Rate, and 

the number of Days past due before the finance charge will be assessed. 

6. Click  to save the changes, then close Customization. 
 

Note: If the Customization window was previously saved, the window will not be opened automatically. 

Once Customization is saved, the Key Type, Decimal Places, and First Month of Reporting Year fields 

will be dimmed and must be changed using the Change Key Type or Change Beginning Reporting 

Month programs.  

Entering Firm Information for Statements & Reporting Purposes 

Use System Configuration to enter your firm’s name for reporting purposes. System Configuration 

includes configuration for Tabs3, PracticeMaster and Tabs3 Financial Software. Your firm’s name and 

address information is also used for statements.  

1. Start Tabs3. 
2. From the Application Toolbar, click the System Configuration toolbar button as shown 

in the image on the right.  
3. The System Configuration window will be opened. From the File menu, point to Open 

and select Firm.  
4. Enter your Firm’s name and other information.  

5. Click  to save the changes.  
6. Close the System Configuration window. 

 
Tip: System Configuration is also used to create user accounts and define privileges for individual users 

who will be using the software. 

Tip: See Statement Designer for more 

information on customizing statements. 

Step 2 – Add Timekeepers & Rates  
Next, you need to set up timekeepers. Timekeepers are the individuals in your office whose time is billed 

to clients. 

To add timekeepers 
1. From the Tabs3 Task Folders, click Setup and then click Timekeeper. 
2. From the Timekeeper tab: 

a. Press Ctrl+N to add a new timekeeper number.  
Tip: Most firms use “1” for the senior partner. 

More Info – Firm Information 
Help Topics – Press F1 in the Firm Information window 

System Configuration Manual – Chapter 2:  Data Entry  

http://www.tabs3.com/support/manuals/stmanual.pdf


Tabs3 Getting Started Guide  4 | P a g e  

 

b. Click the drop-down arrow in the Level field to select the timekeeper level. 
Tip: Additional levels can be defined via Setup | Timekeeper Level Description. 

c. Enter the timekeeper’s name 
(e.g., John J. Smith). 

d. Enter the timekeeper’s initials 
(e.g., JJS). 

3. In the Rates section:   
a. Enter the timekeeper’s default 

hourly billing rate in the Rate 1 
field. 

b. You can use Rate 2 for a premium rate, discounted rate, court rate, etc. However, it is 
best to use Rate 2 consistently for all timekeepers. For example, if Rate 2 is the court 
rate, make sure Rate 2 is the court rate for all timekeepers. Enter any additional rates as 
desired. 

4. Click  to save the changes. 
5. Add additional timekeepers as needed by repeating steps 2 through 4. 

 
Tip: Custom billing rates can be set up at the client level. See Fee Rate Tables for more information. 

Using Tabs3 
Once you’ve set up your timekeepers and rates, you’re ready to add clients and fees, and then run 

statements. 

Step 3 – Add Clients  
Clients are added to Tabs3 using the Client program. When you add a client, a contact record is created 

for the individual or organization. Contact records can be used by other clients and matters. 

To add clients 
1. From the Main Task Folder, click the Client icon. 
2. Address tab: 

a. Press Ctrl+N to add a new client.  
i. The New Client Record window will be displayed. Select the desired option for 

the Client ID you want to use to identify the client. 
ii. Click OK. 

b. Enter the Client Name (e.g., 
Jones/Mary T. or United 
Insurance Company). 

c. A Contact Information window 
will be displayed allowing you to 
enter the address and phone 

information for the contact. Enter the desired information and click  to save the 
changes. 

d. After saving the contact information, you are returned to the Address tab of the client 
file with the contact information already filled in.  

More Info – Timekeepers & Rates 
Help Topics – Press F1 in the Timekeeper window 

Training Videos – Billing Video Library | How Rates Work 

Tabs3 Manual – Chapter 3:  Billing Methods & Other Features 

                                                   Hourly Billing 

More Info – Clients & Contacts 
Training Videos – Clients & Contacts Video Library (8 videos) 

                 

Help Topics – Press F1 in the Client or Contact window 

Tabs3 Manual – Chapter 3:  Data Entry  

http://www.tabs3.com/support/manuals/t3manual.pdf
http://www.tabs3.com/support/manuals/t3manual.pdf
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3. On the Setup tab, specify the desired Billing Category and Primary Timekeeper. 
4. On the Billing Preferences tab, under Statement Delivery Options, double-click the first record 

in the table. This is where you designate whether the client will receive a printed statement 
and/or an e-mail statement.  

5. Click OK to close the Bill To Record and then click  to save the changes. 
 

Tip: When entering information for a potential client, enter the information in a Contact record. Then, 

when the contact becomes a client, use the contact record to populate the client record. You can access 

the Contact file using the Contact icon on the Main or Client Task Folders. 

Step 4 – Add Fees & Costs  
Fees and costs are entered using the Fee and Cost programs. 

To add fees 
1. From the Main Task Folder, click the Fee icon.  
2. By default, the last accessed client ID is used for the default. Select the desired client by doing 

one of the following: 

 Press Enter to accept this client ID. 

 Type in a different client ID. 

 Click the drop-down button to select a different client from the Client Lookup window.  
3. Press Enter in the Reference field to add a new fee.  
4. Select the desired Timekeeper. 
5. Enter the desired Date. 
6. Click the drop-down button in the Tcode field to select the desired tcode. Tcodes represent a 

type of service or activity. 
Tip: Tcodes are optional. If desired, use tcode 1 and type your own description. 
Tip: Right-click the Tcode field and select Edit Transaction 
Code to add or edit tcodes. 

7. Enter the Hours Worked. For example, 15 minutes would be 
entered as .25 hours. 

8. After selecting the desired tcode, the default tcode 
description will be used in the Description field. Edit this field 
as desired.  
Tip: Use tcodes or Tabs3 text macros to create commonly 
used phrases or paragraphs to aid in faster data entry. 

9. Click  to save the changes. 
 

Detail vs. Rapid Entry Mode 

The Fee Entry program has a detail mode and a rapid mode. The steps above use the fields in Rapid 

mode. Let’s take a look at Detail mode. 

 While in the Fee window, click the Detail/Rapid  button.  
 

When in Detail mode, additional fields are shown above the Description including the Hours to Bill, Rate, 

and Amount fields. Furthermore, additional fields are shown below the Description field including 

More Info – Fees 
Training Videos – Adding Fees 

                                 Recap of Hours 

Help Topics – Press F1 in the Fee window 

Tabs3 Manual – Chapter 3:  Data Entry  

http://www.tabs3.com/support/manuals/t3manual.pdf
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Category, Bill Code, Rate Code, Status, Sales Tax, User ID, and Date Entered. When you are in Rapid 

mode, the text Rapid Fee is shown in the title bar. 

Fee Entry List 

You can see a list of fee transactions by using the Toggle List  button (or Alt+G). Notice that the 

transaction you saved is shown in the list. If you want to edit the transaction, simply double-click the 

entry to retrieve it in the data entry form. After making any changes, click  to save the changes. 

Recap of Hours 

While in the Fee program, click the Recap of Hours  button to view a Recap of Hours window. This 

window shows the cumulative hours worked for the specified timekeeper on any given day. This makes 

it easy for timekeepers to see whether any time entries are missing. 

Tip: From the Transactions Task Folder, click the Recap of Hours icon to run a Recap of Hours Report for 

any time period. This report shows a calendar with the number of billable and non-billable hours for 

each day by timekeeper.  

Verification Lists 

When you close the Fee program, you will be given the opportunity to print a Verification List. Verif-

ication Lists are optional and include a list of the transactions that were entered, changed, or deleted 

during the session. Verification Lists are also available for the Cost and Payment data entry programs. 

Working with Costs  
In Tabs3, costs are classified as expenses or advances. Expenses are “soft” or “indirect” costs, whereas 

advances are “hard” or “direct” costs. Costs are classified differently for accounting and tax purposes. 

Examples of expenses include photocopy expenses, long distance, postage, etc. Examples of advances 

include filing fees, witness fees, medical costs, etc.  

Tip: You can show expenses and advances separately on the statement, or you can combine them. 

To add costs 
1. From the Main Task Folder, click the Cost icon.  
2. Enter the desired client ID. 
3. Press Enter in the Reference field to add a new cost. 
4. Enter the desired Date. 
5. Click the drop-down button in the Tcode field.  

a. Notice that the list of tcodes is different for costs. This 
is because each tcode is assigned a Fee, Expense, or Advance attribute when it is 
defined. Notice the Type column in the Tcode lookup window shows E or A, thus 
indicating whether the tcode is an expense or advance. 

b. Select the desired tcode. 
6. Notice a Units and Rate field is available. These fields can be used for mileage or photocopies, 

for example. 
7. Enter the Amount. 

More Info – Costs 
Training Videos – Adding Costs 

Help Topics – Press F1 in the Cost window 

Tabs3 Manual – Chapter 3:  Data Entry  

http://www.tabs3.com/support/manuals/t3manual.pdf
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8. Enter the Description. 

9. Click  to save the changes. 
 

Like the Fee Entry program, you can use the Detail/Rapid  button to toggle between Detail and Rapid 

Mode. You can use the Toggle List   button to hide or display a list of costs at the bottom of the 

window. When you exit the Cost Entry program, you will be given the option to print a Cost Entry 

Verification List.  

Step 5 – Run Statements  
Once all fees and costs have been entered, you can run a statement for the client. 

To run a statement 
1. From the Statements Task Folder, select Generate Statements. 
2. On the Client tab, specify the desired client for the beginning and ending Client ID, or leave 

these fields blank to print statements for all clients. 
3. On the Transactions tab, you can specify a cut-off date for fees and costs if desired. 
4. On the Options tab, select Draft. We want to run a draft statement for review purposes. 

Tip: Select the Print Reference Numbers check box to include reference numbers on statements 
to assist with selecting individual transactions for editing purposes. 

5. Click OK. 
6. You can either print or preview the statement. Click Preview to review the statement on screen. 

 
When reviewing the statement in the Preview window, you can easily modify any transaction by moving 

your mouse over the transaction description, then clicking it when it turns yellow. After saving any 

changes to the transaction, you will be returned to the statement. Click the Refresh button at the 

bottom of the Preview window to refresh the 

statement with your changes.  

Changing the Statement Format 

Statement format is controlled by statement 

templates. Each client is assigned a statement 

template for draft statements and one for final 

statements. Tabs3 also includes a Statement 

Designer that provides the ability to create 

customized page layouts for your Tabs3 

statements. Once designed, page layouts can be 

applied to one or more statement templates. 

Let’s say after reviewing the statement, you 

want to change the format of the fees so it shows hours and rates. The statement format can be 

changed via the Client file. However, if you still have the statement displayed in the Preview window, 

you can open the Client file by moving the mouse over the Account No. at the top of the statement and 

clicking it when it turns yellow. 

More Info – Statements 
Training Videos  

 Statements Overview 

 E-mailing Statements  

 Customizing Statements 
 

Help Topics   

 Type Statements on the Index tab and select Overview 

 Press F1 in the Generate Statements, Statement Designer, 
and Statement Templates windows 
 

Tabs3 Manual – Chapter 6:  Statements 

                              Sample Reports Chapter includes statement examples 

Knowledge Base Article R11338 – E-mailing Tabs3 Statements  

                  http://www.support.Tabs3.com/main/R11338.htm 

http://www.tabs3.com/support/manuals/t3manual.pdf
http://www.support.tabs3.com/main/R11338.htm
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To change the statement format 
1. Open the Client File by doing one of the following: 

 When previewing a statement, mouse over the Account No. at the top of the statement 
and click it when it turns yellow. 
       …or… 

 From the Main Task Folder, click Client. 
2. Click the Statement Options tab. 
3. Right-click in the Draft Template field (or Final Template field) and select Edit Statement Templates. 
4. Click the Fee Format tab. 
5. Under the Include section that is right of the Fee Format section: 

a. Select the Rate check box. 
b. In the Hours drop-down list, select Detail.  

6. After making all changes to the statement template: 
a. Press Ctrl+S to save the changes.  
b. Close the Statement Template window. 
c. Close the Client window.  

7. Rerun the statement. If you are still in the Preview window, simply click the Refresh button to 
rerun the draft statement.  
 

Tip: Keep in mind that changing the statement template affects all clients that use that template. 

Generate a Final Statement  

Once you approve the draft statement, you must run a final statement. This can be done the same way 

the draft statement was run by changing the Statement Type from Draft to Final on the Options tab. Or, 

it can be run using the Pre-Bill Tracking window. 

Generating a Final Statement via Pre-Bill Tracking 
1. From the Statements Task Folder, click Pre-Bill Tracking. 
2. Highlight the desired client ID. 
3. Click the Reviewed button at the bottom of the window to indicate the statement was 

reviewed. 
4. Click the Final Statements button to generate a final statement. 
5. Click OK. 

Pre-Bill Tracking  

The Pre-Bill Tracking window makes it easy to track the status of statements. When draft statements are 

run, a statement record for that batch of statements is added to the Pre-Bill Tracking window. As draft 

statements are reviewed, you mark them as reviewed or on hold. You can then easily run final 

statements directly from the Pre-Bill Tracking window for all statements that have been reviewed. The 

Pre-Bill Tracking window provides a centralized location that 

shows the status of all pending statements. 

Tip: Some firms prefer to use Detail Work-In-Process Reports 

instead of draft statements to review information before billing. 

Running Detail Work-In-Process Reports also adds statement 

records to the Pre-Bill Tracking window. 

More Info – Pre-Bill Tracking 
Training Videos – Pre-Bill Tracking Video 

Help Topics – Press F1 in the Pre-Bill Tracking window 
 
Tabs3 Manual – Chapter 6:  Statements:  Pre-Bill Tracking 

http://www.tabs3.com/support/manuals/t3manual.pdf
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Step 6 – Update Statements  
Now that the final statement has been generated, you must update the statement using the Update 

Statements program. This process finalizes the statement and sends the information to accounts 

receivable and other productivity reports. 

To update a statement 
1. From the Statements Task Folder, click Update Statements. 
2. If prompted to make a backup, click Yes. 
3. After the backup completes, the Update Statements window will be displayed. Specify the 

desired client ID you want to update, or leave the fields blank to update all final statements for 
all clients. 

4. Click OK. 

Step 7 – Print Accounts Receivable Report  
When statements are updated, the information is updated to accounts receivable and other reports. 

Let’s look at an accounts receivable report. 

To print a Summary Accounts Receivable Report 
1. From the Accounts Receivable Task Folder, click Summary A/R Report. 
2. On the Client tab, specify the desired client (or leave the Client ID fields blank to select all 

clients). 
3. Click the Options tab and select any desired options. 
4. Click the Format tab and select any desired options. 
5. Click OK. 
6. Click Preview when the Print Summary 

Accounts Receivable Report window 
displays. 

7. After you’ve finished viewing the report, 
click the Close button at the bottom of the 
Preview window. You will be returned to 
the report window allowing you to run 
another report if desired. 

 
Tip:  There are other accounts receivable reports available on the Accounts Receivable Task Folder.  
Tip:  After clicking the Task Folder icon for any report, press F1 while in the criteria selection window 

for the report. In the heading bar of the help topic, click the icon. This icon opens the Sample 
Reports, which shows an example of the report and provides detailed information for every item on 
the report.  

Step 8 – Enter Payments  
Upon receipt of a client’s payment, you need to enter a payment transaction. 

To add payments 
1. From the Main Task Folder, click the Payment icon.  

More Info – Reports 
Training Videos  

 Reports Overview 

 Detail and Summary Accounts Receivable Reports 
 

Help Topics – Press F1 in the Accounts Receivable Report window 

Tabs3 Manual 

 Chapter 7:  Reports 

 Sample Reports Chapter 
 

http://www.tabs3.com/support/manuals/t3manual.pdf
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2. Enter the desired Client ID. 
Tip: Notice that the client’s accounts receivable balance is shown at the bottom of the window 
after specifying the Client ID. 

3. Press Enter in the Reference field to add a new payment. 
4. Enter the desired Date. 
5. Click the drop-down button in the 

Tcode field and select the desired 
tcode.  

6. Enter the Amount. 
7. Enter the Description. 

8. Click  to save the changes. 
 

Once the payment is entered, the accounts receivable automatically reflects the payment. However, in 

order to process the payment, a final statement must be run and updated that includes the payment. 

This typically occurs when the next statement for the client is run. If no other work will be performed for 

the client, then you can run a payment-only statement.  

Tip: You can run a report of all cash receipts (Reports | Management | Cash Receipts Report). 

Step 9 – Client Manager  
The Tabs3 Client Manager shows client contact information, balance due information, work-in-process 

information, and the date of the last statement and payment. You can launch the reports you run most 

often for individual clients. The PracticeMaster button launches the Matter Manager in PracticeMaster, 

which provides quick access to other case related information.  

To launch the Client Manager, do one of the following: 

 From the Main Task Folder, click the Client Manager  icon 

 From the File Menu, select Client Manager 

 Press Ctrl+M 
 

Resources  
This Getting Started Guide provides you with the information you need to start using the software. 

There are many other resources available to help you learn the software. 

Training Videos  
Tabs3 and PracticeMaster include numerous training videos to help you learn the software. Training 

video libraries are installed with the software and can be accessed via the software from the Help | 

Training Videos menu option.  

More Info – Payments 
Training Videos – Adding Payments,  Credit Card Processing,  

                                 Receipt Allocation, Payment Types,  

                                 Method to Apply Payments, Manual Payment Allocation  

Help Topics – Press F1 in the Payment window 

Tabs3 Manual – Chapter 3:  Data Entry  

http://www.tabs3.com/support/manuals/t3manual.pdf
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Help  

Help is installed with the software and is easily accessed by pressing F1, by clicking the button, or by 

selecting the Help | Help Topics menu option. Help includes detailed information regarding specific 

programs. Clicking the button opens Help for the window you are currently using. Many times, 

reading the appropriate Help topic may be the fastest way to find your answer. 

Manual  
The Tabs3 manual is installed with the software in PDF format. Shortcuts are created during installation. 

From the Start menu, point to Tabs3 & PracticeMaster | Documentation | Tabs3 | Tabs3 Manual. The 

manual includes information on basic setup and use of the software. It provides an overview for all 

features in the software. Manuals can also be accessed via our Web site at 

http://www.Tabs3.com/support/docs.html.   

Tabs3 Reports  
The Tabs3 Reports packet is installed with the software in PDF format along with the manuals. Tabs3 has 

dozens of reports and this packet makes it easy to see examples of each report. Many firms will print 

this packet as a reference guide for the various reports to help familiarize them with what is available.  

Knowledge Base  
Tabs3 and PracticeMaster publish an extensive Knowledge Base on the Internet with advanced 

information. It contains information on Error Troubleshooting, Networking & Windows Issues, “How To” 

articles, and product-related articles. You can access the Knowledge Base via the software from the Help 

| Internet Resources | Knowledge Base menu option or from your Internet browser at 

www.support.Tabs3.com/.  

For example, as a new Tabs3 user, you may want to learn more about Tabs3. Knowledge Base Article 

R11103, “Tabs3 Frequently Asked Questions,” provides numerous questions and answers on various 

areas of the software. Although the Help provided with the software also includes much of this 

information, you may find that the comprehensive focus of many Knowledge Base articles may be quite 

helpful for certain subjects. 

Technical Support  
Tabs3 and PracticeMaster provide some of the best technical support in the industry. Service to our 

customers is extremely important to us—so much so that our motto is:  

Reliable software. Trusted service.  

Technical Support is provided at no charge with a maintenance plan and is available from 8:00 a.m. to 

5:00 p.m. Central Time, Monday through Friday. If you have any questions, please feel free to call our 

Technical Support staff at (402) 419-2210. 

http://www.tabs3.com/support/docs.html
http://www.support.tabs3.com/
http://www.support.tabs3.com/main/R11103.htm
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Tabs3 Resellers & Consultants 
Tabs3 and PracticeMaster products are available through a national network of over 250 resellers and 

consultants. Those resellers and consultants are small independent firms that specialize in the sales, 

installation, training and support of billing, financial, and practice management software for law firms. 

By having resellers and consultants service all 50 states, you can work directly with a local person 

familiar with Tabs3 and PracticeMaster software, who can provide personalized on-site installation, 

training, and support services. Visit our Web site at www.tabs3.com/resellers/resellers.html for a 

reseller near you or contact our Sales staff at (402) 419-2200.  

Thank you for choosing Tabs3 and PracticeMaster software. We look forward to serving your practice 

management and billing needs with reliable software and trusted service or many years to come. Let us 

know how we can help you get started with Tabs3 and PracticeMaster. 

 

http://www.tabs3.com/resellers/resellers.html
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